NHANH SUBLIME TEX

Piéu hudng, chinh stfa, multi-cursor, tim kiém, packages

€éu hudng
Diéu hudng file & symbol
Ctrl+P Mg file nhanh theo tén (fuzzy)
Ctrl+R Pi téi symbol trong file
Ctxl+Shift+R Ditdi symbol trong project

Ctrl+G Di tdi s6 dong

Ctxl+; Di téi tir trong file

Diéu huéng tab & panel

Ctrl+Tab Chuyén qua cac tab dang mg
Ctxl+PageUp/Down Tab trudc /tiép theo
Alt+1..9 Chuyén dén tab theo s6 th tu
Ctrl+K Ctrl+B Bat/tat sidebar

Ctrl+ Bat/tat console
Tién t6 Goto Anything

;) Ditdidong (Ctrl+P roi :42)

@ Ditdi symbol (Ctrl+P rdi @func)

#F) Ditditu (Ctrl+P r6i #search)

Chinh sua

Thao tac dong

Ctrl+Shift+K Xéa dong
Ctrl+Shift+D Nhan déi dong
Ctxl+Shift+Up/Down Dichuyén donglén/xudng
Ctrl+d NGi cac dong
Ctrl+Enter Chen dong phia sau
Ctrl+Shift+Enter Chen dong phia trudc
Thao tic vin ban

Ctrl+Shift+U Viéthoa selection

Ctrl+K Ctxl+L

Viét thudng selection
Ctrl+K Ctrl+U

Viét hoa selection (thay thé)

Ctrl+] Thut & dong

Ctrl+[ B9 thut [é dong

Ctrl+/ Bat/tat comment

Ctxl+Shift+/ Bat/tat block comment

Md rong & Thu hep

Ctxl+D Chon tif (ldp lai dé thém lan xuat hién tiép)
Ctrl+K Ctxl+D B0 qua céi hién tai, chon [an xuat hién tiép
Ctrl+Shift+L Tach selection thanh tiing dong

Ctrl+L Chon toan bo dong

Ctrl+Shift+M Chon ndi dung bén trong dau ngodc
Ctrl+Shift+A Chon ndi dung bén trong tag

Ctrl+Shift+Space Mdrong selection téiscope
Chontatcakétqua )

Alt+F3 Chon tat ca [an xuat hién cua tif
Ctrl+Shift+F Tim trongfiles (toan project)
Multi-Cursor

Thém cursors

Ctrl+Click Thém cursor tai vi tri click

Ctxl+D Thém lan xuat hién tiép vao selection
ALt+F3 Chon tat ca [an xuat hién lam cursors
Ctrl+Shift+L Thém cursor vao moi dong dudc chon

Ctrl+Alt+Up/Down Thém cursor phiatrén/dudi
Quy trinh Multi-Cursor

. Select word: Ctrl+D

. Add next match: Ctrl+D (repeat)

. Skip match: Ctrl+K, Ctrl+D

. Type replacement — edits all at once

. Esc to return to single cursor

[CFNWINTS

Tim & Thay thé

Ctrl+F Tim trong file

Ctrl+H Tim va thay thé

Ctxl+Shift+F Tim trongfiles (toan project)

F3 / Shift+F3) Kétquatiép/trudc

Alt+Enter Chon tat ca két qua (trong panel tim)
Ctrl+E Dung selection dé tim
Ctrl+Shift+E Dung selection dé thay thé

Ty chon tim kiém (bat/tét trong Find Panel)
ALt+R Bat/tat ché do regex

ALt+C Bat/tat phan biét hoa thudng

ALt+W Bat/tat khdp toan tif

Alt+L Bat/tat tim trong selection

Command Palette

Cach dung

Ctxl+Shift+P.  M&Command Palette

type to filter Tim kiém lénh fuzzy

Lénh hitu ich

Set Syntax: [lang]
Convert Indentation
Sort Lines

Reindent Lines
Install Package
Toggle Woxd Wrap
Build Systems

Lénh Build

Ctrl+B Chay build
Ctrl+Shift+B  Chon build system va chay
F4 / Shift+F4) Kétqua build tiép /trudc
Build System tuy chinh

Thay déi syntax highlightin:

Chuyén d(”)yi tabs/s%acegs J

Sép xép cac dong dugc chon theo alphabet
Ty ddng thut (€ selection

Mg trinh cai ddt Package Control

Bat/tat xuéng dong mém

// Tools > Build System > New Build System

"cmd": ["python3", "s$file"],
"selector": "source.python"

-~
]

Packages

Package Control

Ctrl+Shift+P » Install Caidat package
Ctrl+Shift+P » Remove GG bo package
Ctrl+Shift+P » List Liét ké packages da cai
Ctrl+Shift+P -» Disable V0 hiéuhda package
Packages pho bién

Emmet M@ rong viét tét HTML/CSS
SublimeLinter Framework linting
GitGutter Hién thi git diff trong gutter

SideBarEnhancements Thao tacfile sidebar md rong

A File Icon Icon loai file trong sidebar

Texminus Panel terminal tich hgp

Cai dat

Cac file cai dat

Preferences > Settings M file JSON cai ddt ngudi dung
Preferences > Key Bindings MG key bindings clia ngudi dung
Project > Edit Project Cai dat theo project

Cai dat thudéng dung

{

"font_size": 14,

“tab size": 2,

"translate_tabs to spaces": true,

"trim trailing white space on save": true,
"ensure_newline at eof on_save": true

‘

Cac mau thudng dung

Chinh sifa chia d6i

Alt+Shift+1 B& cuc mét cot
Alt+Shift+2 B3 cuc hai cot
Alt+Shift+3 BG cuc ba cot
Alt+Shift+4 B& cuc bdn cot
Alt+Shift+5 B6 cuc luGi (2x2)
Alt+Shift+8 B& cuc hai hang

Ctrl+Shift+[1..4] Dichuyén file sangnhémN
Phim tat ning suat
Ctrl+K Ctrl+0
Ctrl+K Ctrl+]
Ctrl+K Ctrl+l..9

M& tat ca
M tat ca (cach thay thé)
Gap déncap do N

Ctrl+Shift+[ Gap selection
Ctrl+Shift+] MG selection

Fl11 Bat/tat toan man hinh
Shift+F11 Bat/tat ché do distraction-free
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sections:
  - title: "Điều hướng"
    page_break_before: false
    subsections:
      - title: "Điều hướng file & symbol"
        type: table
        rows:
          - key: "Ctrl+P"
            desc: "Mở file nhanh theo tên (fuzzy)"
          - key: "Ctrl+R"
            desc: "Đi tới symbol trong file"
          - key: "Ctrl+Shift+R"
            desc: "Đi tới symbol trong project"
          - key: "Ctrl+G"
            desc: "Đi tới số dòng"
          - key: "Ctrl+;"
            desc: "Đi tới từ trong file"

      - title: "Điều hướng tab & panel"
        type: table
        rows:
          - key: "Ctrl+Tab"
            desc: "Chuyển qua các tab đang mở"
          - key: "Ctrl+PageUp/Down"
            desc: "Tab trước / tiếp theo"
          - key: "Alt+1..9"
            desc: "Chuyển đến tab theo số thứ tự"
          - key: "Ctrl+K Ctrl+B"
            desc: "Bật/tắt sidebar"
          - key: "Ctrl+`"
            desc: "Bật/tắt console"

      - title: "Tiền tố Goto Anything"
        type: table
        rows:
          - key: ":"
            desc: "Đi tới dòng (Ctrl+P rồi :42)"
          - key: "@"
            desc: "Đi tới symbol (Ctrl+P rồi @func)"
          - key: "#"
            desc: "Đi tới từ (Ctrl+P rồi #search)"

  - title: "Chỉnh sửa"
    page_break_before: false
    subsections:
      - title: "Thao tác dòng"
        type: table
        rows:
          - key: "Ctrl+Shift+K"
            desc: "Xóa dòng"
          - key: "Ctrl+Shift+D"
            desc: "Nhân đôi dòng"
          - key: "Ctrl+Shift+Up/Down"
            desc: "Di chuyển dòng lên / xuống"
          - key: "Ctrl+J"
            desc: "Nối các dòng"
          - key: "Ctrl+Enter"
            desc: "Chèn dòng phía sau"
          - key: "Ctrl+Shift+Enter"
            desc: "Chèn dòng phía trước"

      - title: "Thao tác văn bản"
        type: table
        rows:
          - key: "Ctrl+Shift+U"
            desc: "Viết hoa selection"
          - key: "Ctrl+K Ctrl+L"
            desc: "Viết thường selection"
          - key: "Ctrl+K Ctrl+U"
            desc: "Viết hoa selection (thay thế)"
          - key: "Ctrl+]"
            desc: "Thụt lề dòng"
          - key: "Ctrl+["
            desc: "Bỏ thụt lề dòng"
          - key: "Ctrl+/"
            desc: "Bật/tắt comment"
          - key: "Ctrl+Shift+/"
            desc: "Bật/tắt block comment"

  - title: "Chọn vùng"
    page_break_before: false
    subsections:
      - title: "Mở rộng & Thu hẹp"
        type: table
        rows:
          - key: "Ctrl+D"
            desc: "Chọn từ (lặp lại để thêm lần xuất hiện tiếp)"
          - key: "Ctrl+K Ctrl+D"
            desc: "Bỏ qua cái hiện tại, chọn lần xuất hiện tiếp"
          - key: "Ctrl+Shift+L"
            desc: "Tách selection thành từng dòng"
          - key: "Ctrl+L"
            desc: "Chọn toàn bộ dòng"
          - key: "Ctrl+Shift+M"
            desc: "Chọn nội dung bên trong dấu ngoặc"
          - key: "Ctrl+Shift+A"
            desc: "Chọn nội dung bên trong tag"
          - key: "Ctrl+Shift+Space"
            desc: "Mở rộng selection tới scope"

      - title: "Chọn tất cả kết quả"
        type: table
        rows:
          - key: "Alt+F3"
            desc: "Chọn tất cả lần xuất hiện của từ"
          - key: "Ctrl+Shift+F"
            desc: "Tìm trong files (toàn project)"

  - title: "Multi-Cursor"
    page_break_before: false
    subsections:
      - title: "Thêm cursors"
        type: table
        rows:
          - key: "Ctrl+Click"
            desc: "Thêm cursor tại vị trí click"
          - key: "Ctrl+D"
            desc: "Thêm lần xuất hiện tiếp vào selection"
          - key: "Alt+F3"
            desc: "Chọn tất cả lần xuất hiện làm cursors"
          - key: "Ctrl+Shift+L"
            desc: "Thêm cursor vào mỗi dòng được chọn"
          - key: "Ctrl+Alt+Up/Down"
            desc: "Thêm cursor phía trên / dưới"

      - title: "Quy trình Multi-Cursor"
        type: code
        content: |
          1. Select word: Ctrl+D
          2. Add next match: Ctrl+D (repeat)
          3. Skip match: Ctrl+K, Ctrl+D
          4. Type replacement — edits all at once
          5. Esc to return to single cursor

  - title: "Tìm kiếm"
    page_break_before: false
    subsections:
      - title: "Tìm & Thay thế"
        type: table
        rows:
          - key: "Ctrl+F"
            desc: "Tìm trong file"
          - key: "Ctrl+H"
            desc: "Tìm và thay thế"
          - key: "Ctrl+Shift+F"
            desc: "Tìm trong files (toàn project)"
          - key: "F3 / Shift+F3"
            desc: "Kết quả tiếp / trước"
          - key: "Alt+Enter"
            desc: "Chọn tất cả kết quả (trong panel tìm)"
          - key: "Ctrl+E"
            desc: "Dùng selection để tìm"
          - key: "Ctrl+Shift+E"
            desc: "Dùng selection để thay thế"

      - title: "Tùy chọn tìm kiếm (bật/tắt trong Find Panel)"
        type: table
        rows:
          - key: "Alt+R"
            desc: "Bật/tắt chế độ regex"
          - key: "Alt+C"
            desc: "Bật/tắt phân biệt hoa thường"
          - key: "Alt+W"
            desc: "Bật/tắt khớp toàn từ"
          - key: "Alt+L"
            desc: "Bật/tắt tìm trong selection"

  - title: "Command Palette"
    page_break_before: false
    subsections:
      - title: "Cách dùng"
        type: table
        rows:
          - key: "Ctrl+Shift+P"
            desc: "Mở Command Palette"
          - key: "type to filter"
            desc: "Tìm kiếm lệnh fuzzy"

      - title: "Lệnh hữu ích"
        type: table
        rows:
          - key: "Set Syntax: [lang]"
            desc: "Thay đổi syntax highlighting"
          - key: "Convert Indentation"
            desc: "Chuyển đổi tabs/spaces"
          - key: "Sort Lines"
            desc: "Sắp xếp các dòng được chọn theo alphabet"
          - key: "Reindent Lines"
            desc: "Tự động thụt lề selection"
          - key: "Install Package"
            desc: "Mở trình cài đặt Package Control"
          - key: "Toggle Word Wrap"
            desc: "Bật/tắt xuống dòng mềm"

  - title: "Build Systems"
    page_break_before: false
    subsections:
      - title: "Lệnh Build"
        type: table
        rows:
          - key: "Ctrl+B"
            desc: "Chạy build"
          - key: "Ctrl+Shift+B"
            desc: "Chọn build system và chạy"
          - key: "F4 / Shift+F4"
            desc: "Kết quả build tiếp / trước"

      - title: "Build System tùy chỉnh"
        type: code
        content: |
          // Tools > Build System > New Build System
          {
            "cmd": ["python3", "$file"],
            "selector": "source.python"
          }

  - title: "Packages"
    page_break_before: false
    subsections:
      - title: "Package Control"
        type: table
        rows:
          - key: "Ctrl+Shift+P → Install"
            desc: "Cài đặt package"
          - key: "Ctrl+Shift+P → Remove"
            desc: "Gỡ bỏ package"
          - key: "Ctrl+Shift+P → List"
            desc: "Liệt kê packages đã cài"
          - key: "Ctrl+Shift+P → Disable"
            desc: "Vô hiệu hóa package"

      - title: "Packages phổ biến"
        type: table
        rows:
          - key: "Emmet"
            desc: "Mở rộng viết tắt HTML/CSS"
          - key: "SublimeLinter"
            desc: "Framework linting"
          - key: "GitGutter"
            desc: "Hiển thị git diff trong gutter"
          - key: "SideBarEnhancements"
            desc: "Thao tác file sidebar mở rộng"
          - key: "A File Icon"
            desc: "Icon loại file trong sidebar"
          - key: "Terminus"
            desc: "Panel terminal tích hợp"

  - title: "Cài đặt"
    page_break_before: false
    subsections:
      - title: "Các file cài đặt"
        type: table
        rows:
          - key: "Preferences > Settings"
            desc: "Mở file JSON cài đặt người dùng"
          - key: "Preferences > Key Bindings"
            desc: "Mở key bindings của người dùng"
          - key: "Project > Edit Project"
            desc: "Cài đặt theo project"

      - title: "Cài đặt thường dùng"
        type: code
        content: |
          {
            "font_size": 14,
            "tab_size": 2,
            "translate_tabs_to_spaces": true,
            "trim_trailing_white_space_on_save": true,
            "ensure_newline_at_eof_on_save": true
          }

  - title: "Các mẫu thường dùng"
    page_break_before: false
    subsections:
      - title: "Chỉnh sửa chia đôi"
        type: table
        rows:
          - key: "Alt+Shift+1"
            desc: "Bố cục một cột"
          - key: "Alt+Shift+2"
            desc: "Bố cục hai cột"
          - key: "Alt+Shift+3"
            desc: "Bố cục ba cột"
          - key: "Alt+Shift+4"
            desc: "Bố cục bốn cột"
          - key: "Alt+Shift+5"
            desc: "Bố cục lưới (2x2)"
          - key: "Alt+Shift+8"
            desc: "Bố cục hai hàng"
          - key: "Ctrl+Shift+[1..4]"
            desc: "Di chuyển file sang nhóm N"

      - title: "Phím tắt năng suất"
        type: table
        rows:
          - key: "Ctrl+K Ctrl+0"
            desc: "Mở tất cả"
          - key: "Ctrl+K Ctrl+J"
            desc: "Mở tất cả (cách thay thế)"
          - key: "Ctrl+K Ctrl+1..9"
            desc: "Gấp đến cấp độ N"
          - key: "Ctrl+Shift+["
            desc: "Gấp selection"
          - key: "Ctrl+Shift+]"
            desc: "Mở selection"
          - key: "F11"
            desc: "Bật/tắt toàn màn hình"
          - key: "Shift+F11"
            desc: "Bật/tắt chế độ distraction-free"
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